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Microsoft Power Tools for Data Analysis #04: 

Power Query: Import Multiple Excel Files & Combine (Append) into 

Proper Data Set 

Notes from Video: 
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1. Goal of Video: 

1) Import multiple Excel Workbook files with multiple tables, extract Excel Workbook file and sheet tab 

names as new columns, append all tables into one proper data set, and build PivotTable report that can 

be refreshed when new files arrive. Here is a summary picture: 

 
 

2. Main Difficulty When Importing Multiple Excel Files is that each Excel file may have multiple objects that 

need to be included or excluded in the query. 

1) In last video, when we tried to import multiple text files, we did not have the issue of multiple objects in 

a single file because each text file contained only one Proper Data Set, as seen in this picture: 

 
 

Import Many Excel Files, Append, Build Report

Just One Object 
in Text File
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2) When we try to import multiple Excel files, each individual Excel file can have one or more objects in an 

Excel File. For example, in this picture the Excel file named “Oakland.xlsx” contains many objects such as 

sheets with Proper Data Sets, Excel Tables and Print Ranges, as seen in this picture: 

 
 

3) When we build our query to go and get the data from multiple Excel workbook files, we will have to 

build the query so that it imports only the objects that contain the data we want. 

4) Types of objects that we may encounter when we import an Excel Workbook file using Power 

Query are: 

i. An Excel Worksheet with all its data 

ii. An Excel Table 

iii. A Defined Name 

iv. A Print Range 

v. A Table that has had the Filter Feature Used 

vi. Automatic Defined Name Created when you use the Advanced Filter feature and you use a 

Criteria Range 

vii. Automatic Defined Name Created when you use the Advanced Filter feature and you use an 

Extract Range 

5) Our Goal is to import only objects that are Sheets and have a SalesRep Sheet Tab Name, as seen in this 

picture of the “Oakland.xlsx” Workbook File: 

 

Many Objects in Excel File

Import Only Excel Sheets with a SalesRep Name
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3. Import Multiple Excel Files From Folder. 

1) For our example these are the files that are sitting in the folder named “004-MSPTDA-ExcelFiles”: 

 
 

2) In the above list of files, we only want files that have an extension that contain “.xls”, and because some 

of the files names have extensions in capital letter and some have lower case letters, we will have to 

convert them all to lower case letters before importing them. 

3) In Excel to import files from a folder, we can: 

i. Click on the Data Ribbon Tab. 

ii. Go to the Get & Transform group. 

iii. Click on the Get Data dropdown arrow. 

iv. Point to From File. 

v. From the sub-menu, click on From Folder option. 
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4) To point Power Query to the folder that contains the files we want to import, we: 

i. In the Folder dialog box, click the Browse button. 

ii. In the Browse for Folder dialog box, navigate to the folder named “004-MSPTDA-ExcelFiles”, 

then click on that folder. This is the folder that Power Query is point to in order to find files to 

import. 

iii. Click OK in the Browse for Folder dialog box. 

 
 

5) The Folder dialog box now contains the folder path that Power Query will use when we later need to 

refresh our query. If the folder path ever changes, we are allowed to come back and edit this folder 

path. To point Power Query to this folder path, click the OK button. This picture shows the Folder dialog 

box: 

 
 

6) Click Transform Data!! In the next step click the Transform Data button to open the query in the 
Power Query Editor, as seen here: 
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Load buttons. 
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7) In the Power Query Editor, we can see the file name column is the second column and that there the 

subsequent columns are attributes about the file. The first column is named Content and is the column 

that contains the file. The first step for any query is always to give the Query a smart name. As seen 

here, we named it “AllExcelSheetDataIntoOneTable”: 

 

 
 

8) Change Query Options for Data Types. Before we start transforming the data using Power Query, we 

can turn off the default option to automatically change the Data Type for columns with unstructured 

data (not obvious what sort of data type the column contains, or the data source does not specify a Data 

Type) by: 

i. Clicking the File Menu Dropdown Arrow. 

ii. Click on Options and settings. 

iii. Click on Query Options. 

 
 

9) Then in the Query Options dialog box: 

i. On the Left, click Data Load. 

ii. Uncheck the check box for “Automatically detect column types and headers for unstructured 
sources”. 
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10) In the Content column, if you click to the right of the word Binary in the third row, you can see the 

“Oakland.xlsx” in the bottom of the query, as seen here: 

 
 

11) Because Power Query is case sensitive, and we have some extensions listed with capital letters and 

some with lowercase letters, we can “clean” the extensions to become all lowercase by: 

i. Right-clicking the Extension column. 

ii. Point to Transform. 

iii. Click on lowercase. 

 
 

12) To filter out non-Excel files, go to the Extension Field, click the Filter Dropdown Arrow, point to the 

Text Filter option, then click on “Contains” option. Then in the Filter Rows contains text box, type “.xls”, 

as seen here: 
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Contains Condition = “.xls” 

This filter will import these file 

extensions: 

• .xls 

• .xlsx 

• .xlsm 

• .xlsb 
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13) Clean File Name. Next, we need to “clean” the Name column so that only the City File Name remains. 

First, we must: 

i. Right-clicking the Name column. 

ii. Point to Split Column. 

iii. Click on By Delimiter. 

 
 

14) When the Split Column by Delimiter dialog box pops up: 

i. Type the Delimiter period (dot). 

ii. Click dialog button for ”Right-most delimiter”. 

iii. Click OK. 

 
 

15) This will give us the file that we want to import and transform, as seen in the picture below. As soon as 

this filtered list appears, rename the Name.1 column by double clicking the column header and typing 

the word “City”, as seen below: 
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16) Next, we need to remove all columns except the Content and City columns. To do this we click on the 

Content Column, then hold the Ctrl Key and click on the City Column. Then with both columns selected, 

right-click one of the two columns and point to Remove Other Columns, as seen here: 

 
 

17) Custom Column using Excel.Workbook Function. In order to extract the correct objects from each 

Excel File, we need to add a Custom Column. Custom Columns allow us to use formulas (like we would in 

Excel) to accomplish a task that is not available in the Ribbon Tabs. When we add our Custom Column, 

we will use the Power Query Function (M Code) called Excel.Workbook. To add a Custom Column, go to 

the Add Column Ribbon Tab, then in the General group click the Custom Column button, as seen here: 

 

 
 

 

18) Then in the Custom Column dialog box: 

i. In the New column name textbox, type the name: “GetExcelObjects”. 

ii. In the Custom column formula textbox, type the formula: 

 

= Excel.Workbook([Content],true) 
 

iii. Then click OK. 
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column that contains the 
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Custom Column, the function 
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Excel File. 
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19) The result of the Custom Column is seen below. 

i. The Custom Column named GetExcelData delivers a table for each row that gives us information 

about what kind of objects are in each Excel File. 

ii. If you click to the right of the word table in the first cell of the GetExcelData column, you can see 

a table appear in the lower part of the query. 

iii. The table in the lower part of the query has five columns that give us information about what 

type of objects are in the Excel File. For example, in the “Kind” column we can see that some of 

the objects are Excel Worksheets (Sheet), one is an Excel Table (Table) and some are Defined 

Names (DefinedName). This information will help us to filter the objects and import only object 

that have data that we want. 

 

 
 

20) The next step is to remove the Content column, so we right-click the Content column and click on 

Remove. 

21) To expand the tables in each row and repeat the City name for each row associated with that file: 

i. Click Expand button. 

ii. Uncheck “Use original column name as prefix”. 

iii. Click OK. 
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22) The Expanded Table with each Excel Files objects looks like this: 

i. The City column repeats the City File Name for each row that belongs to the specified file. 

ii. The Name and Item columns are similar in that they contain the name of the object. The Item column has slight more descriptive name 

for the Defined Names because the name also lists the Excel Worksheet Name as part of the full name. 

iii. The Data column contains the data for each object. 

iv. The Kind column tells us what type or “Kind” of object contains the data from the Data column. We can use this column, for example, 

to filter and then import on Sheet objects. 

v. The Hidden column tells us whether or not the object is hidden. For example, the Defined Name for the table that had the Filter 

Feature Applied (row 6) shows TRUE in the Hidden column because this is a Hidden Defined Name in an Excel Workbook File. 

 
23) Headers Have Been Promoted. To prove to ourselves that the second argument in the Excel.Workbook Function actually did promoter the 

first row of each table, so they became Field Names, we can click to the right of the word “Table” in the second row of the Data column. The 

table that appears in the lower part of the Query Editor, shows the Proper Data Set with Field Names. 
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24) Filter to import only Sheet Objects. With the goal of filtering out objects that are not Sheet Objects, 

we can: 

i. Click the Filter Arrow in the Kind Column 

ii. From the Unique List of items, uncheck everything except for “Sheet” 

iii. Clock OK. 

 
 

25) Filter to remove Sheet objects that Begin with “Sheet”. To remove Sheet Objects that have not 

been properly named with a SalesRep name, go to the Name Field, click the Filter Dropdown Arrow, 

point to the Text Filter option, then click on “Does not begin with” option. Then in the Filter Rows “does 

not begin with” text box, type “Sheet”, as seen here: 

 
 

26) Now we are left with only rows that contain Proper Data Sets where the object is a Sheet object and the 

Sheet Name does not begin with the word “Sheet” (has a SalesRep Name), as seen here: 

 
 

27) In the above picture, the “Name” column does not have a useful name. In order to change the name, 

double lick and change the column name to “SalesRep. 
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28) The final columns we need for our Appended Proper Data Set are: 

i. Data (contains the correct Proper Data Sets) 

ii. City (contains the correct City name) 

iii. SalesRep (contains the SalesRep name). 

29) To remove the unwanted columns, select the columns using the Ctrl Key by first clicking on the Data 

column, then the City column, and finally the SalesRep column. With the columns selected, right-click 

any one of the columns and then click on Remove Other Columns, as seen in the picture below: 

 
 

30) Final Append with all Proper Data Sets. To complete our final append process to combine all the 

Proper Data Sets into a single table with six columns, click on the expand button in the Data column, 

uncheck the “Use original column name as prefix” and then click OK. 
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31) Here is a picture of the final Proper Data Set, including the last Power Query transformation stop on adding the correct Data Types for each 

column. There should be 15 steps in the Import, Extract, Clean, Transformation and Load Query, as seen in the below picture: 

 
 

32) Load to Excel Sheet. Because we only have about 60,000 rows of data (not a lot of data), and our calculations can be done with a Standard 
PivotTable, and we would like to see the data in a sheet (so we can filter and sort), we will load the data to an Excel Worksheet. To Load to the 
Excel Sheet named data, we use the Close & Load dropdown in the Home Ribbon Tab, then select the “Close and Load To…” option and load 
the data as a Table in cell A1 on the Data Sheet. The Import Data dialog box is seen here: 
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4. Change Default PivotTable Layout & Options. If we would like our PivotTables (both Standard and Data 
Model PivotTables) to have the Tabular Layout by default so that Field Names are used rather than generic 
labels in a PivotTable, we can change it by going to Options in the File Menu, then: 

i. On the Left, click on the Data Tab. 
ii. Then on the right, click the Edit Default Layout button, as seen here: 

 
 

2) In the Edit Default Layout dialog box, we can change a number of default settings including: 

i. Using the dropdown in the Report Layout textbox to select “Show in Tabular Form”. This setting 

will force PivotTables to use Field Names as labels in a PivotTable report rather than the generic, 

“Row labels” and “Column labels”. 

ii. The PivotTable Options button opens the PivotTable Options dialog box with many settings you 

can change, as seen here: 
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3) We built a PivotTable Report: 

 
 

5. Definition of a PivotTable. In the video we reminded ourselves of what we learned in the prerequisite class: 

the essence of a PivotTable is that it makes calculations with conditions or criteria. In the picture below, we see 

that the selected cell is making a sum calculation with four conditions or criteria or filters. We also reminded 

ourselves that the definition of a PivotTable is: Summary Reports with Calculations based on One or 

More Conditions or Criteria. 

 
 

6. AND Logical Test. We also reminded ourselves that an AND Logical Test means that in order for the record to 

be included in the calculation, all conditions or criteria must be met. 
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7. Add New Excel Workbook Files to the Folder & Refresh. As we saw in the video, when we added new files 

to the folder that met all the conditions of the query, and we refreshed both the Query and the PivotTable (two 

separate refreshes), the data from the new file was incorporated into the Query Load To Output and the 

PivotTable report. 

i. We can refresh the Query in a few different places: 

1. In the Queries & Connections Pane, we can right-click the Query and click on Refresh. 

2. In the Queries & Connections Pane, we click the refresh icon in the upper right corner of 

the query. 

3. We can use the Refresh or Refresh All button in the Data Ribbon Tab in the Queries & 

Connections group. 

4. We can right-click the Query Load To Output in the Excel Worksheet and click on 

Refresh. 

ii. We can refresh the PivotTable 

1. We can right-click the PivotTable and click on Refresh. 

2. We can use the Refresh or Refresh All button in the PivotTable Tools Analyze Ribbon Tab 

in the Data group. 

iii. If we Load the Power Query Transformation to an Excel Sheet, we have to perform two separate 

Refreshes: 

1. First Refresh the Query. 

2. Second Refresh the PivotTable 

iv. If we Load the Power Query Transformation to a PivotTable (option in the Import Data dialog 

box), all we have to do is refresh the PivotTable one time, and then both the Query and 

PivotTable report are refreshed. 

8. Edit Query when Folder Path Changes. If the Folder Path changes, the you must edit the first step of the 

query and change the incorrect folder path to the correct folder path. 


